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The Sage ERP MAS 90 and 200 road-
map, that Sage published earlier this 
year, called for more frequent, easy-to-

install, focused enhancement releases. And 
Sage has delivered, providing customers on 
maintenance plans with three Product Updates 
since Version 4.4 shipped earlier this year.

In this article, we will cover Product 
Update 3 (Version 4.40.0.3) that became 
available September 2010. In this third 
Product Update, Sage delivers new customer-
requested functionality focusing on the Bank 
Reconciliation module, to streamline work-
flow and resolve bank reconciliation pain 
points.

Smooth General Ledger Posting
When you receive your bank statement 

there are usually transactions, such as adjust-
ments and bank fees, that are not yet in your 
Sage ERP MAS 90 system. Product Update 
3 improves the workflow for these entries, 
allowing you to enter the adjustments and 
post to the General Ledger directly from 
the Check, Deposit and Adjustment Entry, 
and Reconcile Bank screens. You also can 
efficiently convert the Bank Reconciliation 
Report and Bank Reconciliation Transaction 
Register to a PDF format for easy electronic 
filing and distribution to others, using new 
Bank Reconciliation Paperless Office features.

New Columns Facilitate Workflow
The improved flow of information to the 

General Ledger is accomplished via new col-
umns on the Check, Deposit and Adjustment 
Entry screen. The new columns are: Select 
for General Ledger Posting, Distribution 
Account Number, and Comment for Checks. 
These fields also are available when entering 
checks, deposits, and adjustments on the fly. 
The information that you put in the com-
ment field will flow through to the General 
Ledger when the transactions are posted. 

Quick Access To Bank Recap
Another customer enhancement request is 
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to have access to the knowl-

edgebase that includes articles 
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the ability to access the Bank Recap 
Report and the Bank Reconciliation 
Register more quickly. With Product 
Update 3, you can access both of 
these reports from buttons located 
on the Reconcile Bank window.

New Transaction Register 
A new Transaction Register task 

has been added to the main menu 
for Bank Reconciliation to provide 
the ability to post selected transac-
tions to the General Ledger module. 
You also can print the Transaction 
Register directly from the Check, 
Deposit and Adjustment Entry, and 
Reconcile Bank screens.

To safeguard against unintentionally creat-
ing duplicate entries, posting only is allowed 
for those transactions entered directly into the 
Bank Reconciliation module.

New Security Events
The new workflow includes added security 

events in Role Maintenance to restrict who 
can use the new features:
»» For the Bank Reconciliation Transaction 
Register a new Allow Updating of Registers 
from Preview is added as a standard 
security event.

»» For the Bank Reconciliation module a 
new Allow Access to the Select for G/L 
Posting Setting for Check Entries and 
Allow Access to the Select for G/L Posting 
Setting for Deposit and Adjustment 
Entries are added as standard security 
events.

Paperless Office For Bank 
Reconciliation 

The Bank Reconciliation module goes 
green and joins the other core modules 
with the ability to create a PDF file of Bank 

Reconciliation reports. You can choose to 
print the Bank Reconciliation Report and 
Bank Reconciliation Transaction Register by 
specific bank codes, or by all bank codes. 

Flexible Paperless Office features give 
you the ability to easily e-mail or fax the 
PDF documents. Once converted, the 
Bank Reconciliation Report and Bank 
Reconciliation Transaction Register can be 
saved in the archive for easy recall, with com-
plete security.

Microsoft Office 2010 
Compatible

With the release of Product Update 3, Sage 
ERP MAS 90 and 200 now are compatible 
with the latest version of Microsoft® Office, 
Office 2010. Now you can take advantage of 
the new features of Office 2010 when creat-
ing mail merge letters or exporting to Excel 
from Sage ERP MAS 90 and 200.

Available Via Download
Product Updates have been designed to 

be easy to download and install. The com-
pact file containing Product Update 3 can 

be downloaded from Sage Online. Product 
Update 3 includes a Pre-Installation Data 
Scan utility to help identify any data issues 
prior to installation, thus mitigating the pos-
sibility of running into trouble with data con-
version. Please give us a call for assistance with 
the Product Update or with your questions 
about the new features.�
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The new Check, Deposits, and Adjustment Entry screen includes 
columns for General Ledger Posting information, and two buttons 
for quick access to reports. 

(( Tips & Tricks ))

Printing Journals And Registers To 
PDF Files 

In order to print journals and registers 
to PDF files, you first need to configure 
Paperless Office Options, as follows: 
1.	 Expand Modules, Paperless Office, and 

Setup. Double-click Paperless Office 
Options. 

2.	 Select the Journals and Registers check box 
under Enable Electronic Delivery and PDF 
Storage. 

3.	 In Setup, double-click Journal and Register 
Maintenance. 

4.	 Select either a company code or the All 
Companies option. 

5.	 Select either a module code or the All 
Modules option. 

6.	 Select either a particular document or the 
All Documents option. 

7.	 Click the Browse Directory button, and 
select the folder to use for storing the PDF 
files. 

8.	 Select an option from the Auto Create PDF 
list: Yes = The document always prints to 
PDF; No = The document always print to 
hard copy; Prompt = The “Do you want 
to print in PDF format” dialog box always 
appears. 

http://www.keystonesoftware.com/starinfo/mas90/p610/zoom_in.html


Helpful Hints For Sage ERP MAS 90

Changing Mailing Label Formats
The default graphical mailing labels in 

Sage ERP MAS 90 and 200 are designed to 
print one, two, or three labels across and 10 
labels down. Here we give you several options 
if you need to print using a different label lay-
out, such as 2 across and 3 down. Before you 
start, make sure you know the exact size of 
your labels.

Option 1 - Crystal Reports®:
1.	In Crystal Reports, in the form design 

screen for mailing labels, right click on any 
of the Details sections.

2.	Select the Format Section option and 
highlight the Details section.

3.	Click on the Layout tab and change the 
height and width to the appropriate size. 
Notice at the bottom of the Layout Tab, 
the Number of Details has changed.

Option 2 - The Report Expert:
The Report Expert found on the Report 

menu also can be used to modify forms to a 
standard Avery size; however, it tends to refor-
mat the form quite a bit. Be sure to make a 
copy and work with the copy of the label 
form if you select this option.

Option 3 - Custom Report:
Create a Custom Report from scratch. 

Choose Mail Label from the Report Gallery 
in Crystal Reports. A wizard will step you 
through the creation of a label type report. 
You can then add the labels to the Custom 
Reports menu using Report Manager.

Adjusting Margins For Labels
The default three across labels normally 

fit on Avery 5160 label stock, but on certain 
printers you may need to adjust the margins 
slightly. This is done from the File menu by 
selecting Page Setup. Changing one margin 
to 0.18” will usually correct the problem. 

Improving Performance In Sage 
MAS Intelligence

Sage MAS Intelligence is the new reporting 
and analysis software that replaces Microsoft 
FRx. If you have large amounts of data, com-
pacting the metadata can improve the perfor-
mance of the system as it removes unneces-
sary connections and unneeded background 
files. To compact metadata:
1.	Open Sage MAS Intelligence Report 

Manager. 
2.	Select File/Compact Metadata.
3.	Select Yes to the question: To compact your 

Metadata Alchemex must shut down. Do 
you wish to continue? 

4.	In the Maintenance Utility window select 
the Compact SVD button. 

5.	Select Yes at the prompt: This will attempt 
to compact your server Metadata file. Please 
make sure that there are no users logged on to 
the system before continuing. If you want to 
proceed press Yes, or else press No to abort.

6.	Once the process has completed Copying, 
Deleting, and Compacting you will 
receive a prompt: Completed Successfully. 
Select OK.
A backup copy file named alchemex_

backup.svd will be created during this com-
pact process. Once you have verified that the 
system is working correctly after the compact 
then you can delete it, or keep it as an addi-
tional backup.�

Customizer Changes Do Not 
Appear To Take Effect

If you have made changes to Sage ERP 
MAS 90 windows through Customizer, but 
the changes do not appear to take effect, they 
may have been overridden by Personalizations 
the individual user has made to the screen. 
For example, the user moved the Comment 
field to the lower grid on the Lines tab for 
Sales Order Invoice Data Entry. To have the 
customizations show up, you can reset the 
default window settings as follows:
1.	Open the window that displays incorrectly 

and right-click anywhere within the 
window. 

2.	From the context menu, point to Form 
Settings, and click Reset Form. 

3.	Select one of the following check boxes 
and click OK.

»» Reset All Grids (windows with data entry 
grids).

»» Reset Window Size and Position (all other 
windows).

4.	Close and reopen the window. The 
window should reset to the default 
settings, and the Customizer changes 
should now display.
Note: This hint applies to modules 

upgraded to the Business Framework in level 
4.0 and higher.�  
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In the Spotlight:

Do you have ideas about improving your 
Sage ERP MAS 90 and 200 system? 

Sage takes customer feedback very seriously. 
Recently, Sage made it even easier for you to 
provide input. Let’s learn more.

A History Of Customer Input
Using customer feedback to improve the 

product is nothing new at Sage. Usability tests 
are performed with actual customers before 
a new version is released, and a Customer 
Advisory Council provides input on a regular 
basis. Over the years you may have partici-
pated in various types of surveys in which you 
were asked for product feedback, whether by 
mail, on the phone, or via the Internet.

This extremely valuable information helps 
Sage understand your challenges and then 
determine what can be done to improve your 
experience. Your feedback influences prod-
uct plans, helps prioritize features and func-
tionality in each release, and drives product 
roadmaps.

New In-Product Survey
Rather than you having to go to a partic-

ular screen or website to provide feedback, 
the new in-product survey launches auto-
matically. After you install a new release or 
Product Update, the software gives you a few 
weeks to absorb all the new features, and then 
prompts you for your feedback while it is still 
fresh in your mind.

Launching surveys within the Sage ERP 
MAS products is an effective way of obtaining 

feedback from those people on your team 
who use the software on a regular basis. The 
following versions of Sage ERP MAS prod-
ucts support in-product surveys:
»» Sage ERP MAS 90 and 200 4.4 (after 
applying a Product Update)

»» Sage ERP MAS 90 and 200 4.3 (after 
applying recent Product Updates)

Your Choice
It is not always convenient to complete a 

survey on the spur of the moment. Taking 
the survey is optional; you may opt to take it 
immediately, decline the survey, or ask for a 
reminder at a later time. A Privacy Statement 
explains how the information will be used.

When you choose to take the survey, it will 
open a browser window and link to a Web-
based survey. The survey will take approxi-
mately five minutes to complete, is comprised 
of no more than 12 single select questions, 
and also provides the opportunity for you to 
make comments and provide open feedback.

The in-product survey is one of many Sage 
initiatives focused on gaining a deeper under-
standing of your needs. Also available is the 
Sage ERP MAS 90 and 200 Feedback site, 
www.sagemas.com, where you can submit 
enhancement requests, or read and vote on 
others’ suggestions. The Sage ERP MAS 90 
and 200 Online Community is a collabora-
tive space where you can share product tips 
and tricks with other customers: click here.

We encourage you to take the time to 
tell Sage about your product experience. Of 

course if you prefer, you may provide your 
feedback directly to us and we will make sure 
Sage hears about it.�

Provide Feedback To Sage With The New In-Product Survey
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